Using Olis GlobalWorks
Powerful Software for Data Analysis

Table of Contents
1: Installation of Olis GlobalWorks............................................................................................................................................ 1
System Requirements............................................................................................................................................................ 2
Setup Procedure...................................................................................................................................................................... 3
Registration of Olis GlobalWorks....................................................................................................................................... 5
2: Menu Functions............................................................................................................................................................................. 6
Menu Bar..................................................................................................................................................................................... 7
Data Display Screens............................................................................................................................................................12
Data Display Options Menu.............................................................................................................................................. 16
Data Processing Menu.........................................................................................................................................................16
Peak Finder...............................................................................................................................................................................19
Edit Dataset............................................................................................................................................................................. 20
Edit Axis Data..........................................................................................................................................................................22
3: Basic Operations.......................................................................................................................................................................... 23
Opening a Dataset/Experiment....................................................................................................................................... 24
Naming an Experiment....................................................................................................................................................... 24
Saving........................................................................................................................................................................................25
Cutting, Copying, and Pasting...........................................................................................................................................25
Deleting from the Experiment Window........................................................................................................................26
Changing the Axis Scale..................................................................................................................................................... 26
Zooming................................................................................................................................................................................... 26
Printing......................................................................................................................................................................................27
Exporting Charts....................................................................................................................................................................27
4: Working with Datasets............................................................................................................................................................. 28
Viewing Data...........................................................................................................................................................................29
Truncating a Dataset (Extract Trace as a New Dataset)...........................................................................................29
Performing Mathematical Operations...........................................................................................................................30
Adding Axis Labels............................................................................................................................................................... 30
Fitting a 2D Dataset..............................................................................................................................................................31
Viewing Single Scan from a 3D Dataset....................................................................................................................... 32
Movie of Spectral Ranges of a 3D Dataset...................................................................................................................32

i

Using Olis GlobalWorks
Powerful Software for Data Analysis

Table of Contents
4. Working with Datasets (continued)
Fitting or Exporting a Kinetic Trace from a 3D Dataset
(Procedure for Fitting or Exporting any 2D Trace from a 3D Dataset)...............................................................32
Fitting a 3D Kinetic Dataset Using SVD.........................................................................................................................33
Fitting a 3D Equilibrium Dataset Using SVD............................................................................................................... 34
Exporting a 2D Dataset to ASCII Format.......................................................................................................................35
Exporting a 3D Dataset to Excel...................................................................................................................................... 35
Importing from ASCII Format........................................................................................................................................... 35
Smoothing a 2D Scan.......................................................................................................................................................... 36
Smoothing a 3D Dataset Using SVD.............................................................................................................................. 36
Smoothing a Time Trace with a Digital RC Filter........................................................................................................36
Creating a 3D Dataset from a 2D Dataset.................................................................................................................... 37
Viewing More Than One 2D Dataset on a Single Graph.........................................................................................37
Using Peak Finder to Locate Peaks in a Spectrum.................................................................................................... 38
Changing the Type of SVD Fit...........................................................................................................................................39
Convert Among CD Units...................................................................................................................................................39
Perform Protein Secondary Structure Fits....................................................................................................................39
Convert a Single Detector Trace to Absorbance........................................................................................................40
Correct a Fluorescence Scan for Instrumental Sensitivities...................................................................................40
Take the Derivative of a 2D Dataset............................................................................................................................... 41
Perform Fast Fourier Transform of a 2D Dataset........................................................................................................41
Integrate Under a Peak in a Spectrum.......................................................................................................................... 42
Interpolate a New Axis for a Dataset..............................................................................................................................43
Average a Two-Dimensional (2D) Dataset to One Value.........................................................................................43
Interchange the X and Y-Axes in a 3D Dataset.......................................................................................................... 43
Appendices...........................................................................................................................................................................................44
Appendix 1.............................................................................................................................................................................. 45
Appendix 2.............................................................................................................................................................................. 47
Appendix 3.............................................................................................................................................................................. 49
Appendix 4.............................................................................................................................................................................. 50
References................................................................................................................................................................. 51
Appendix 5.............................................................................................................................................................................. 52
Appendix 6.............................................................................................................................................................................. 53

ii

1.

Installation
OlisDatasets
GlobalWorks
Workingofwith

Installation of Olis GlobalWorks
Olis GlobalWorks is a comprehensive program for the dynamic display and
analysis of 2D and 3D data files collected as a function of time, temperature,
titration, pressure, concentration, or other variables.
The following pages will walk you step by step through the installation process,
from System Requirements, to Setup, to Registration of your software. You will
soon be on your way to using the best 3D data handling and fitting software
package in the world!

!!!Note!!!
Do not install GlobalWorks if SpectralWorks is already installed on your
system (i.e., if the software runs an instrument, SpectralWorks is installed).
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System Requirements

Recommended Hardware:
PII or AMD 500 MHz or better processor
 256 MB RAM
 40 MB free hard drive space
 800x600 resolution
 256 colors minimum


Recommended Operating Systems:


Windows ™ 2000, XP

Software Requirements:
Internet Explorer ™ 5.5 or higher
 HTML Help 1.3 or higher
Note that both Internet Explorer and HTML Help are required to support interactive
tutorials.


(Windows and Internet Explorer are trademarks of the Microsoft ™ Corporation.)
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Do
not install
GlobalWorks if
SpectralWorks is already
installed on your system
(i.e., if the software runs
an instrument,
SpectralWorks is
installed).

!

Setup Procedure
1. Insert the GlobalWorks software CD into the CD drive of the computer.

2. The installation program should start automatically. If it does not start after
a minute, click on Start, then Run, and browse to the CD drive. Choose
Setup.exe on the CD. Click OK to run the setup.

Figure 1.1
Install Welcome
Window

3. At the start of installation, the install welcome screen will appear. Click
Next to continue (see Figure 1.1).

4. Click Yes to agree to the License Agreement.
Figure 1.2
System
Requirements

5. When installing the software, ensure that the computer you are installing it
on meets the minimum requirements (see Figure 1.2 or refer to System
Requirements on page 2).

6. Select the destination location where GlobalWorks will be installed. The
default directory is C:\Program Files\OLIS GlobalWorks. All Olis files,
including demo data files, will be created in this directory (see Figure 1.3).

7. Choose the setup type (see Figure 1.4). It is highly recommended that
Typical be chosen. If a copy of GlobalWorks is already installed on the
computer, this screen will differ. The options will be Modify (choose this to
add a feature), Repair (choose this to reinstall the software over an existing
version of GlobalWorks), and Uninstall (choose this to remove the
program).
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Figure 1.3
Choose
Destination
Location

Figure 1.4
Setup Type
Window
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8. Select the program folder to be created. This is the menu folder
where the GlobalWorks program icon will be located in the Windows
Start menu (see Figure 1.5).
Figure 1.5
Select Program
Folder Window

9. The installation progress will be updated during the setup process
(see Figure 1.6).

Figure 1.6
Setup Status Window

11. The software will report when this installation is complete (see
Figure 1.7). Click Close to continue. You will then see a window that
will list your computer restarting options.

Figure 1.7
Installation
Complete Window

12. After the installation has completed, two windows will appear.
Press any key to continue. This process will allow users other than
the Administrator to use GlobalWorks (see Figure 1.8).

13. The installation of GlobalWorks is now complete. If you have not
restarted your computer, or if it does not automatically restart at
this point, it is recommended that you manually restart your
computer at this time.

Figure 1.8
Folder Permissions
Window

If a Previous Version of GlobalWorks Exists on the Computer:
1. The installation will proceed automatically.

2. The automatic installation will be followed by the appearance of two windows. These set permissions to allow additional
users to access GlobalWorks in the Windows environment. Press Enter for each window.
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If you do not enter
your name and location
exactly as you gave it to
Olis at the time of software
purchase, the program
will not run
successfully.

Registration of Olis GlobalWorks
1. Upon start-up of GlobalWorks, the Registration window will appear (see Figure
1.9). Please enter your name and the location of the computer exactly as you
gave them to Olis when you purchased the software (if the number does not
match exactly, the program will not successfully function). Note that you can
access this screen again by choosing Register Software from the Help menu.
2. There are two choices for obtaining the activation number required for
registration. Choose Activate online if the computer has an Internet
connection or Activate manually if no Internet connection is present (note
that a local firewall may prevent connecting to the Olis website). If a
connection is unavailable, contact you local IT department or activate
manually. Click on Continue Unregistered to register later.
a. Activate Online: If an Internet connection is present, simply
enter the user name and location (exactly as provided to Olis
at the time of purchase), click the Activate online button, and wait.
A message should appear shortly indicating that registration is
now complete (see Figure 1.10).

Figure 1.9
GlobalWorks Registration Window

Figure 1.10
Software Activated Window

b. Activate Manually: Enter the name and location, and then click
the Activate Manually button. A message box will appear (which
may take a few seconds) with a registration number (see Figure
1.11).
1. Contact Olis with this registration number to obtain
your Activation number. Please read the numbers
carefully, as some look very much alike. Once they have
given you your Activation number, click Yes to proceed.
If unable to do so at this time, click No and repeat the
activation process when the number has been obtained.

Figure 1.11
Manual Activation Window

2. After clicking Yes, enter the number exactly as provided by
Olis into the corresponding box (see Figure 1.12).
3. Clicking OK will successfully activate the software.
c. Continue Unregistered: Choosing Continue Unregistered
will allow the software to be used for 30 days without requiring
a registration number. To register at any time during those 30 days,
choose Register Software from the Help menu.
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Figure 1.12
Manual Activation Number Input Window
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Menu Functions
This section will explain the basic menu functions for Olis GlobalWorks. Included in this section
are definitions for each menu, what the name of each menu means and the varied functionality
of each menu. You will learn about the basic menus such as File, View, and Help, as well as
GlobalWorks specific menus like the Data Display Options Menu, Data Processing Menu, and
Peak Finder. Additionally, the menus for the specific data display screens (2D Data Display and
3D Data Display) are broken down and examined for you in this section.
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File

Edit

New Experiment

Copy Slice

This option allows you to
create a new experiment,
which will consist of
protocol and dataset files.

Use this option to select a
slice from among many in
an active 2D dataset. Once
the cursor is active, selecting
Copy Slice from the Edit
menu with designate that
slice as the one to be
copied. Once a slice has
been selected for copying,
Figure 2.2
the selected slice can be pasted
Edit Menu
into a different dataset with
the same collection mode
(i.e. absorbance vs. wavelength, absorbance vs. time, etc.)

Open Experiment
Open a previously saved
experiment (*.ole or *.olg).

Remove Dataset
This option allows you to
remove/close the active
dataset. The name of the
active dataset in this case
was PROTFOLD. The active
window is also indicated in
the experiment window as
well as in the windows title
bar along the top margin
of the window.

Paste Slice
This option becomes active only after you have selected a slice
and applied to Copy Slice option from the Edit menu. The slice
is then available from the clipboard to be pasted into a dataset
with the same collection mode.
Figure 2.1
File Menu

Remove Slice

Startup
Select this option to view the initial startup. From here
convenient windows exist which allow access to existing files,
recently opened files, and tutorials.

This option is used to remove any slice from an active dataset.
Note: In order to make a removed slice visible again, the scan's
number must be entered into the third box of the index
column of the Selected Data Parameters. To activate this table,
click the cursor on any slice.

Open/Open Dataset
This option allows you to open a previously saved dataset.

Save Dataset
Select this option to save the currently active dataset.

Lock On Slice
Once the cursor is active you may select this option from the
Edit menu and the cursor will lock on this slice. Moving the
cursor allows you to travel along the selected scan exclusively.
Information about the 'locked on' slice will appear dynamically
in the parameter table.

Save Dataset As...
This option allows for the current dataset to be saved under a
different name or in a different directory.

Dynamic Slicing

Exit

This option is available only in the 2D view. By selecting a scan
from the collected data and then performing dynamic slicing, a
slice of the scan at the selected wavelength will be displayed in
the right graph.

Choose this option to exit the GlobalWorks program.
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View
Turn Data Cursor
Off
Once a slice is selected
and the cursor
(crosshairs) appears
deactivation requires
the selection of this
option.

Logarithmic Axis
(X-Axis)
When you select this option the program calculates and
displays the Log to the base 10 (Log) of the x-axis.

Logarithmic Axis
(Y-Axis)

2D View
This options allows the
viewing of a
three-dimensional file
Figure 2.3
(typically an *.sc3 file)
View Menu
as a two-dimensional
file with selected scans
on the left and a slice
through the data at some wavelength on the right.

3D View
This option allows for the viewing of a 2D dataset as a
three-dimensional image. The 3D graph created can then be
manipulated (rotated, rescaled, etc.).

When you select this option the program calculates and
displays the Log to the base 10 (Log) of the y-axis.

Experiment Window
All open windows for the active experiment(s) are listed in this
window. Selecting a file from the list makes this selection the
active window. This option allows you to view/hide the
Experiment window.

Properties Window
The parameters of the active window are displayed. The
parameters include name, data, type, full path, etc. This option
allows you to view/hide the Experiment window.

Hide Slice
When the data cursor is active on a slice, this option allows you to
hide (remove from display) the selected slice.

Unhide Slice
When this option is selected all previously hidden slices will
reappear. If multiple scans were hidden, all will reappear
simultaneously.

Swap Hidden/Unhidden Slices
This feature allows you to swap visible slices with slices that
you have previously hidden with the hide slice option.
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Fits
2D Fits

Singular Value
Decomposition (SVD)
Choosing this option initiates
the process of singular value
decomposition (SVD). The
highlighted dataset must be
3D and contain at least ten
points in each axis.

Figure 2.4
Fits Menu

Factor analysis is a multivariate statistical method for
extracting the information content from a dataset. In the Olis
case, we have a large matrix consisting of absorbance, etc. as a
function of both wavelength and time. Factor analysis, in the
Olis case singular value decomposition (SVD), reduces this to
three smaller matrices that contain all the information present
in the data. The kinetic information is contained in a kinetic
eigenvector matrix. Experience has shown that only a small
number of eigenvectors are needed to describe the data. Olis
uses 6. The various rate processes are stored over a small
number of eigenvectors and a kinetic model may be fitted to
those to extract the rate constants. Similarly the spectral
information is stored in a set of six eigenvectors. Finally a
vector of singular values is produced. Typically these start off at
a high value and fall off rapidly to a value near zero. The
number of singular values above zero is an indication of the
number of species significantly present in the data and is
useful for model selection. A representation of the original data
may be obtained by a suitable matrix multiplication of the two
eigenvector sets of vectors and the singular values. This
reconstruction is the original less most of the noise. Thus, the
processes of SVD and reconstruction smooth the data. The
three matrices are commonly used to store the information in
the data in a much more compact form than the original;
about 30 times smaller. It is also much easier to do the global
kinetic fit on the compact kinetic set than the original large
dataset. Thus, factor analysis cleans up the data, affords more
compact storage, and greatly reduces the scale of the global
fitting problem. SVD is one of several methods for factor
analysis and is generally recognized as being the
mathematically most robust. The Olis modifications to SVD in
no way modify the way in which it is used or the conclusions
drawn from it. The only difference is a large gain in speed.

SVD on Data Subset
This initiates the SVD process on only a portion of the
highlighted dataset. The desired data ranges will be prompted
by the program. This option is useful if a portion of the
collected data is unusable or contains little information.
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Two-dimensional kinetic data can be fitted by selecting the
kinetic trace by clicking on the curve, and choosing this option.
A list of possible kinetic mechanisms will be displayed. Choose
the appropriate kinetic mechanism, and the resulting kinetic fit
will be added to the Experiment window. This window
contains kinetic parameters, residuals, and the calculated data.

Compton Fit
Choosing this option after clicking on a circular dichroism scan
allows for prediction of protein secondary structure based on
the algorithm described in Compton, L. A., and Johnson, C. W.
(1986) Anal. Biochem. 155, 155-167.
In order for this option to provide valid results data must be
collected in the prescribed way shown below. Scanning
deeper into the UV will provide more reliable analysis.
Four variants are possible:
41 pts

260 to 178 nm

39 pts

260 to 182 nm

40 pts

260 to 180 nm

38 pts

260 to 184 nm

Variable selection fit
Choosing this option after clicking on a circular dichroism scan
allows for prediction of protein secondary structure based on
the algorithm described in Johnson, C. W. (1999) Proteins:
Structure, Function, and Genetics 35, 307-312.This method
differs from the Compton fit in that it uses eight basis spectra
which are extracted from a set of twenty-six spectra of known
proteins.The spectra are selected to be those which most
resemble the spectrum to be fit, which must be from 178 nm to
260 nm and contain one point per nm (83 points).

Menu Functions

Tools
Options (continued)

Data Processes

SVD Type
The data processes listed
under the Tools menu are
identical to those described
in the Data Processing
Menu section (pages 16-17).
Figure 2.5
Tools Menu

Reconstruct 3D from
SVD Data
This option utilizes the eigenvectors to produce a 3D dataset
similar to the original data (source of the SVD eigenvectors)
but with much of the noise removed.

Choose between the Matheson SVD algorithm, which utilizes
wavelength compression, or the original Golub-Reinsch (Golub
G., Reinsch C. Singular Value Decomposition and Least Squares
Solutions, in Wilkinson J.H. and Reinsch C.(editors) Handbook for
Automatic Computation, vol II. Springer. 1971.) algorithm. The
Matheson method uses matrix exponentiation (Zamis, T. M.,
Parkhurst, L. J., and Gallup, G. A. (1989) Computers in Chemistry,
13, 165-171.) and is significantly faster than the
original algorithm. The default type uses a either algorithm
depending on dataset size. The Matheson technique is more
appropriate for large datasets (>10,000 points).
SVD Data Display Options

Reconstruct 3D from 2D data
This option allows for the conversion of a 3D data file (*.sc3) to
a 2D data file.

Create data subset
By entering new wavelength and time values, a subset suitable
for fitting can be created from the original data; this facility will
be used if one wishes to 'trim' a dataset which may contain
data deemed unsuitable for fitting.

Dataset Repair
This option is used to remove an errant data point, which may be
affecting a kinetic fit. Once a questionable data point (or region)
has been selected, the data will be replaced by an average of a
user-selected adjacent data region.

The two options available for SVD data display are the Olis
square root display and the conventional display. This option
changes the SVD eigenvector display only and has not effect on
the data itself. In the Olis display, spectral data are presented as
the square root of the eigenvector value, which serves to
de-emphasize the spectral component of the eigenvector and
reduce the potential or inclusion of spectral artifacts into the fit.
For this reason, this display is the default display.
Misc.
Automation
This option is only applicable to SpectralWorks (in which the
software control an instrument. See the SpectralWorks manual
for use of the automation software. The options given here to
Save Data Files in the .ols Format or Save Data Files in
2-Column ASCII Format refer to the Automation mode. When
data files are automatically generated by SpectralWorks, they
will be saved in the format specified here. See Appendices 1 and
2 for descriptions of these formats.

Options
Report Options
Use this page to change the default color for printing to black
and white or to choose whether or not to print the data cursor
on the graph.
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Chart

Help

Reset Chart

Tutorial

This option allows the
restoration of the active
chart to its original
condition (i.e., unhides
hidden slices, resets zoom or
scaling, etc.).

Reset All Charts

Matheson-DeSa
Fitting Tutorial

Figure 2.6
Chart Menu

This option allows for the restoration of all active data charts to
their original condition (i.e., unhides hidden slices, resets zoom
or scaling, etc.).

This option allows
you to activate an
interactive tutorial
guiding you step by
step through applying
global fit to your dataset.

Figure 2.7
Help Menu

Contents
Access the help index.

Zoom
To activate the zoom function you must be viewing 2D data
and the cursor must be active on a slice. Clicking and dragging
your mouse cursor allows you to create an outline of the data
which once zoomed in on will consume the entire area
designate to the data screen. To undo this function select
Reset Chart from the Chart menu.

Obtaining Technical Support
This option allows you to email your technical concerns
directly to Olis’ technical support department at
techsupport@olisweb.com.

Olis, Inc. on the web
Scaling
When this option is activated the active chart can be rescaled
in its window using mouse movements.

If you have an internet connection, this option sends you to
our website, www.olisweb.com.

Register Software
Print Chart
This option allows for the printing of the chart actively selected
by the cursor.

Copy to Clipboard
Once this option is selected a copy of the active dataset is
saved to the clipboard which can then be pasted as an image
file to any program which allows the importation/pasting of an
image file from the clipboard.
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After your trial has ended you can select this option to
purchase GlobalWorks software and receive your registration
number and unlock key.

About
This screen contains information about the software including
your version number, trial expiration date, and registration
information.

Menu Functions

2D Data Display

Comments
This section allows for the user to add comments that
will remain with the file when it is saved. After data
collection, useful instrument settings will be reported
here.

Selected Data Parameters
This table indicates the location of the cursor, which
can be activated by clicking on the data.
The X and Y values are recorded under Absorbance and
Wavelength. None refers to the fact that there is no third axis
(i.e. the data is two-dimensional).
The Index column refers to the datum number of the dataset.
Only independent variables will have an index value (e.g., time,
scan number, wavelength).

Figure 2.8
2D Data Display Screenshot
(1EXP.ols sample data)

Properties Window
This window lists properties of the file being displayed, such as
number of data points, date collected, and dataset name.

Experiment Window
Every open window, including the data collection window is
listed here. When a new dataset or fit is generated, a new entry
is added to this window. Move between windows by clicking on
the datasets in this window.

The dataset name can be changed here by double clicking on
Name and entering in a new name followed by hitting the
return key. This is not the file name, but only a name for display
that will be saved with the data.
Data can be saved by selecting Save As under the File menu.

To delete a window, make it the current window, and click in the
lower X in the upper right-hand corner.
Data can also be selected for data processing here by
right-clicking and choosing Select. The data processing options
become active in the right-click menu. Among these options
are arithmetic, smoothing, and averaging of data.
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3D Data Display
2D Data View
Pressing this button displays the 3D data as
two 2D graphs. In this case, one graph would
have overlayed spectra and the other has the
kinetic trace at one wavelength.
See page 12 for more information on 2D Data
Display.

SVD
This button initiates analysis of the data using
the Singular Value Decomposition algorithm.
This process can be used to globally fit 3D
data or as a noise filter for the data. A tutorial
on SVD is available under the Tutorial tab in
the Startup menu (Matheson-DeSa Fitting Tutorial).

Figure 2.9
3D Data Display Screenshot
(Xofe125.ols sample data)

Data
The number of scans to be displayed are changed here. A step of “1” shows all data up to 200 scans.

Scale
Clicking this option allows the axis scales to be changed. Autoscale is also available.

Rotation
Clicking this option allows the view to be changed. Degree rotation of axes can be entered or the graph can be dragged after
checking the Rotation box.
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2D Data Display (Multiple
Trace)
Lock On Slice
Once the cursor is active by clicking on data,
you may select this option to lock on a
particular slice of data. Moving the cursor
allows you to travel along the selected scan
exclusively. Information on the “locked on”
slice will appear dynamically in the Selected
Data Parameters window.

Dynamic Slicing
Clicking on this button after selecting a
scan from the collected data will
dynamically display slices at the selected
wavelength in the other graph. This option
is available only in the 2D view.

Figure 2.10
2D Data Display (Multiple Trace) Screenshot
(Xofe.ols sample data)

Remove Cursor
Once a slice is selected and the cursor appears, this button will
deactivate the cursor.

Hide Slice
When the data cursor is active on a slice, this option allows you
to remove from display to a hidden clipboard.

Unhide Slice

Swap Slices
This feature allows you to swap visible slices with slices that
have been hidden with the Hide Slice option. This option is also
available under the View menu.

3D View
This option allows viewing of the 3D data sets as a 3D image.
The 3D image can then be manipulated.
See page 13 for more information on 3D Data Display.

When this option is selected all previously hidden slices will
reappear. If multiple scans are hidden, all will reappear
simultaneously.
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Data Display Options Menu
Assign as Blocked

Scaling

Selecting this option will cause the highlighted scan to be
assigned as a blocked baseline. This scan is obtained by
blocking the sample beam with an opaque object and taking a
scan. Application of the blocked baseline accompanied with
the application of an open baseline will correct for any dark
signal present. This feature is only applicable in SpectralWorks
(software controls an instrument) and is usually applied only to
%Transmission data. Once applied, all subsequent data will be
corrected by the following equation:

To change the scale of
either the X or Y axis, select
this option. A window will
appear to prompt the new
scaling values.

Autoscale
Choosing this option
causes the X and Y axis
to be autoscaled.

Figure 2.11
Data Display Options Menu

Save As ASCII
This option allows for a 2D dataset to be exported as a
two column, tab-delimited ASCII text file with no headers or
footers.
If this option is selected for a 3D dataset, the highlighted 2D
dataset will be exported.

Export Data to Excel
This feature will open the current dataset (2D or 3D) into
Microsoft Excel as a spreasheet.
Micrososft Excel must be installed on the computer for this feature
to work.

Assign as Baseline
Selecting this option will cause the highlighted scan to be
assigned as a baseline, causing this dataset to be subtracted
from subsequent measurements.“Baseline” will appear in the
Live Display and the Apply Baseline checkbox will be checked.
Data collected must be equal to the baseline in number of
points and scan range in the Properties window.
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(S-B)/(O-B)
where S is the uncorrected sample signal, B is the previously
collected blocked signal and O is the previously collected open
signal. Data collected must be equal to the baseline in number
of points and scan range in the Properties window. Uncheck
the Apply Baseline checkbox to remove this correction.

Assign as Open
Selecting this option will cause the highlighted scan to be
assigned as a open baseline. This scan is obtained by
collecting a scan with so sample present. Application of the
open baseline accompanied with the application of an open
baseline will serve as the maximum possible signal. This
feature is only applicable in SpectralWorks (software controls
an instrument) and is usually applied only to %Transmission
data. Once applied, all subsequent data will be applied as
described for Assign as Blocked until the Apply Baseline
checkbox is unchecked. Data collected must be equal to the
baseline in number of points and scan range in the Properties
window.

Menu Functions

Data Processing Menu
Select
To Select a Dataset
-Highlight the desired dataset by left-clicking on it.
-Right-click on the dataset.
-Choose Select from the menu to make the dataset available for processing. A red
checkmark will appear beside the dataset when it is selected.

De-select
This option will unselect the highlighted dataset.

Figure 2.12
Data Processing Menu

De-select All
This option will unselect all datasets.

Apply Constant
To add, subtract, multiply, or divide by a
constant choose Apply Constant. You will
then be prompted to choose the
appropriate operation and constant. The
resulting dataset will be added to the
Experiment window.

Add Selected Datasets
This option will sum all datasets that are
selected. The resulting dataset will be added
to the Experiment window.
Datasets must be of the same type and
contain identical x-axes, as well as the same
number of data points to be added. An error
message will be displayed if an inappropriate
dataset is selected.

Subtract Selected Datasets

Figure 2.13
Data Processing Menu: Processing Multiple Data Sets

Choosing this option with two datasets selected will subtract
the second dataset from the first. The difference will be added
to the Experiment window.
As with adding, the datasets must possess identical x-axes. An error message will be displayed if an inappropriate dataset is
selected.
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Data Processing Menu
(continued)

Multiply Selected Datasets
This option will cause the selected datasets to
be multiplied. The product dataset will be
displayed in the Experiment window.
The datasets must have identical x-axes to
be multiplied. An error message will be
displayed if an inappropriate dataset is
selected.

Average Selected Datasets
This option will average two or more sets of
data with identical x-axes. The resulting
averaged data is added to the Experiment window.

Smoothing
This option allows for a Savitzky-Golay smooth of the selected
data and prompts the user to select from a 3-25 point smooth.
The smoothed dataset will be added to the Experiment
window.

Reverse Data Arrays
This option changes the order in which the data is processed.
This has no effect on the data but may be necessary for
performing SVD on some datasets.

Note: It is important that care is taken to avoid over filtering the
data.

Average Scans Within a Dataset

Derivative

This option averages multiple scans within a dataset. The
resulting dataset will be a 2D dataset added to the Experiment
window.

This option calculates the derivative of the dataset and adds it
to the Experiment window. First through fourth derivatives are
available.

There is also an option to perform this operation during data
collection.

RC Filter
This option applies a simulated time constant to time course
data. The time constant must be specified (in sec or msec) and
cannot exceed the length of the dataset. A rule of thumb for the
maximum time constant without distorting the data is 5-10% of
the total time.
Note: It is important that care is taken to avoid over filtering the
data.
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Figure 2.13
Data Processing Menu: Processing Multiple Data Sets

Build a 3D Dataset from 2D
This option will convert all selected datasets to a 3D file. The
selected datasets must be 2D, and each dataset must contain
consistent values for Y-axis name, units, and a value for each
scan. In addition, the X-axes must be compatible: they must
have the same range and number of data points.

Menu Functions

Data Processing Menu
(Continued)
Synthesize New Dataset
This option prepares a synthetic dataset. After selecting this
option enter the relevant information in the prompt and click
on Synthesize. The only algorithm currently available is linear.

Polarization
This option converts two selected polarization of fluorescence
spectra to polarization units.
The selected datasets must be one spectra calculated with
vertical emission polarizer and one with a horizontal emission
polarizer. The resulting polarization spectrum will be reported
in the Experiment window.

Anisotropy
This option converts two selected polarization of fluorescence
spectra to anisotropy units.
The selected datasets must be one spectra calculated with
vertical emission polarizer and one with a horizontal emission
polarizer. The resulting spectrum will be reported in the
Experiment window.

Corrected Scans
Choosing this option corrects transmission scans for intensity
variations. To correct a spectrum, transmission spectra
obtained with the beam blocked and beam open must be
selected, along with the spectrum to be corrected. The
resulting corrected spectrum will be added to the Experiment
window.

Assign as Open
Clicking this button assigns the selected scan as the "open"
scan for scan correction. This is defined as a scan with no
sample in the beam and should ideally give 100%
transmission.

Assign as Blocked
This option assigns the selected scan as the blocked scan for
scan correction. This scan is taken with the shutter closed and
should ideally result in 0% transmission.

Convert CD Units
This option allows circular dichroism spectra to be converted
to other units. The available units are degrees, millidegrees,
absorbance units, milliabsorbance units, molar extinction, and
molar ellipticity.
See Paul's Practical CD Guide for more detailed information
about circular dichroism units.

Normalize
This button results in division of the selected dataset by the
largest intensity in the dataset. The result is a dataset which
has been internally normalized. This is useful for comparing
shapes of spectra of different intensities.

Dilution Correction
This option corrects the selected dataset for effects of dilution
and is only available for datasets collected with an Olis titration
accessory.
Each scan is corrected by the factor:
Vcurrent
Vinitial

where Vcurrent is the total volume of the sample for the
current scan and Vinitial is the starting sample volume.

Concatenate
This option allows two selected spectra from assays to be
merged into one dataset. If the datasets overlap, the software
will prompt to either choose a dataset or average the
overlapping datasets.

Current Volts to Abs
This function is used to convert a single beam time trace into
an absorbance trace using any region of the curve as a
reference value.

Interpolate
This function is used to change the number of data points or
interval between data points in the selected dataset. A new
dataset range and number of intervals are chosen and the data
is fit by a cubic spline. The new data is computed and added to
the Experiment window.

Correct Fluorescence Scan
This function is used to correct a fluorescence scan for effects
of wavelength changes on the sensitivity of the instrument. A
correction file is chosen to be applied to the data. Contact an
Olis representative for more information on generating a
correction file.
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Peak Finder
Average Counts
The number of points to be averaged at a
time in order to calculate the slope of the
data is entered here. Increasing this number
has the effect of decreasing the sensitivity to
sharp peaks. Thus, a dataset which contains
broad peaks punctuated by noise would
require a relatively large number of average
counts. Conversely, a small number of average
counts is useful for identifying numerous
sharp peaks.

Slope Threshold
This is the criterion for determining if a
change in slope constitutes a peak or noise.
The lower this value, the lower the intensity
of the peaks that will be identified. Typical
values will range from 0.01 to 1.

Peaks Info
Figure 2.14
Peak Finder

The identified peaks will be listed in this table after the Average
Counts and Slope Threshold have been accepted.

Accept
Click this button to accept the current Average Counts and
Slope Threshold. This will result in the identified peaks being
reported in the Peaks Info graph.

Toggle Label
Click this button to add or remove labels for the peaks on the
Peaks Results graph.

Done
Click this button when you are finished. The peak values in the
Peaks Results graph will be included in the dataset
comments, and Peak Finder will be exited.

Cancel
Clicking the Cancel button exits peak finder without
performing a peak fit.

Peaks Results
The location of the peaks which are identified are shown
graphically here. The labels can be turned on or off by clicking
on Toggle Label button.
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Print
Choosing this option prints a report containing the identified
peak values and the graph in the Peaks Results.

Menu Functions

Edit Dataset
Name
Displays the dataset name. This is
not the filename and can be
changed without affecting the
filename.

Parameters
This contains a list of options to
display in the text box below. The
options are Comment, Date of File
Creation, and Sourcefile Name. Only
Comment can be edited here.
All data text can be edited in the
text box; however, only comment
text will be changed in the dataset.

Axis Name
Displays the axis name, which can
be edited. To build 2D scans into a
3D scan they must have the same
axis names in all axes.

Figure 2.14
Edit Dataset Screen

Axis Units

Is Linear

Displays the axis units, which can be edited. To build 2D scans
into a 3D scan they must have the same axis units in all axes.

Indicates whether there is equal spacing between points along
an axis. If Is Linear is "Yes" then the axis can be described by the
number of points, start, and step.
Value=Start+(N-1)*Step, where N is the current data point.

Number of Points
This reports the number of points along this axis. This value
cannot be edited. Rows or columns can be deleted as
described in Remove Column and Remove Row on the following
page.

Start

Edit Axis Data
Clicking on this button allows the X or Y axis data to be
changed.
See page 22 for more information on the Edit Axis Data window.

Indicates the value of the first data point along this axis.

Step
Indicates the interval between data points if the axis is linear
(i.e., has equal spacing between points).
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Edit Dataset
(continued)

Add Column

Y-axis

Use this button to add an additional column (Y data point) to
the end of the dataset. To enter the Y value, choose Edit Axis
Data.

Data in the first row constitutes the Y-axis of the dataset. This
data can be edited by clicking on Edit Axis Data in the Y-axis
window.

See page 22 for more information on the Edit Axis Data window.

See page 22 for more information on the Edit Axis Data window.

Remove Column
Use this button to remove a column from the end of the
dataset. To remove a column or columns other than the end
column, select data to be removed, right-click on the data,
select Axis Options, and choose Remove Axis Point(s).

Add Row
Use this button to add an additional row (X data point) to the
end of the dataset. To enter the X value, choose Edit Axis Data.
Enter or paste data using Cut and Paste.

Expand Data
Clicking on this button enlarges the data window to fit the
entire Edit Dataset window. Clicking on Shrink returns to the
original condition.

Post Data to Globalworks
Clicking this button stores the data in the Experiment window
as a new dataset. The dataset can be saved, viewed in the chart
window, fit, or discarded.

See page 22 for more information on the Edit Axis Data window.

Remove Row

Cancel

Use this button to remove a row from the end of the dataset.
To remove a row or rows other than the end column, select
data to be removed, right-click on the data, select Axis
Options, and choose Remove Axis Point(s).

Quits Edit Dataset without saving any changes.

Cell Contents
This box displays the contents of the selected cell. Data can be
edited in this box. Pressing the Enter key or clicking on another
portion of the screen will enter this data in the dataset.

X-axis
Data in the first column constitutes the X-axis of the dataset.
This data can be edited by clicking on Edit Axis Data in the
X-axis window.
See page 22 for more information on the Edit Axis Data window.
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Edit Axis Data
Cut
Copies selected data to Windows
clipboard and deletes it from the dataset.
The data are then available to paste into
other Windows applications.

Copy
Copies selected data to Windows
clipboard without removing it from the
dataset. The data are then available to
paste into other Windows applications.

Paste
Inserts data from Windows clipboard into
selected data window. This will overwrite
any data that are already present.

Select All
This option selects the entire dataset.

Axis Options
This option allows the selected data to be
deleted. This option is only enabled while
in Edit Axis Data.

Figure 2.15
Edit Dataset Screen
Editing Axis Data

Save Axis Data
Clicking this button will save any changes made to the axis data and return to the full dataset view. This must be done before
clicking Post data to GlobalWorks if changes in axis data are to be retained.

Cancel Axis Edit
This button returns the Edit Dataset form to the full data view without saving any changes made to the axis.
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3.

Basic Operations
This section will cover the most basic operating procedures in the Olis GlobalWorks program.
Included in this chapter are such topics as Opening a Dataset/Experiment, Naming a Dataset,
and Printing a Report of a Dataset. These procedures are the basic processes that all users of
GlobalWorks will need to understand in order to execute the program successfully. Once these
foundational processes are understood, then the more complex operations can be performed
easily.
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Opening a Dataset/Experiment
1. When you open Olis GlobalWorks, you will see a window that gives you the option of opening an Experiment Group,
Experiment, Protocol, or Dataset (see Figure 3.1). If this window does not open automatically, click on File, then either Open
Experiment or Open Dataset.
2. After selecting one of the four choices, another window will open that lists the files available for opening. The default folder will
be the Demo Data folder. If you are looking for a specific experiment, dataset, etc. , you will need to change the “Look In”
location at the top of this folder so that it directs you to the folder where your specific file is located.

Figure 3.1
GlobalWorks Open Experiment
Window

Figure 3.2
Properties Window

Naming a Dataset
1. When a dataset is created by the Olis data collection software SpectralWorks (which may or may not be attached to
GlobalWorks), it is assigned an integer as the dataset name. This integer increases as each dataset is collected. This name is a
title for the dataset and is distinct from the filename, which is not assigned until the data are saved. The name of a dataset can be
changed to make this property more useful.
2. To change the dataset name, double-click on the Name property in the Properties window, which is located in the lower right
portion of the screen (see Figure 3.2). The name property will be selected.
3. Enter a name for the dataset, and press Enter to assign the new name. There is no limitation on the length of the dataset name,
but the new dataset name may not be the same as that of any other open datasets.
4. This name will remain with the dataset and can be edited at any time. The name property will be tagged for a dataset created
by a data process. For example, if dataset 'Baseline' is normalized, the newly created dataset will have the name
'Baseline-Normalized.'
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Saving a Dataset

Saving an Experiment

1. Click on the desired dataset in the
Experiment window, located in the
upper right portion of the screen, to
select it (see Figure 2.3). Note that one
can move among the datasets by
clicking on them in this window.

1. Click on the desired experiment in the Experiment window.
All of the datasets in the Experiment node are contained in
this experiment.

2. If desired, change the dataset name
as described previously (see page 24).

Figure 3.3
Experiment Window
(Datset Selected)

3. Add any comments to the dataset by
clicking in the Comment window in the upper left portion of
the screen and adding text.
4. Right-click on the Comments box to cut, copy, or paste text
(see Figure 2.5).
5. Choose Save Dataset or Save Dataset As… under the File
menu.
6. Enter the filename as prompted. The default filename will be
the dataset name unless an illegal character such as a '\' is
contained in the dataset name.
7. The dataset is saved as an Olis data file with the extension
'.ols'. The file format for .ols files is described in Appendix 2.

2. Choose Save Experiment or Save
Experiment As… from the File
menu. Enter the experiment name
when prompted. If the Save
Experiment option is not available,
ensure that the experiment is
selected in the Experiment window.
Figure 3.4
Experiment Window
3. The program will cycle through all the
(Experiment Selected)
datasets within the Experiment node,
choose Save or Cancel to include or remove, respectively,
the dataset from the experiment. When the experiment is
reopened, all the datasets associated with it are opened. The
datasets are not saved in the experiment, so they must be
saved individually, even though the experiment has been
saved. This file acts as a pointer only, so that multiple
datasets can be opened and closed at one time.

4. To start a new experiment, select New Experiment from the
File menu. A new experiment will be created in the
Experiment window and subsequent datasets will be stored
with it.

Cutting, Copying, or Pasting Text
in the Comments Box
1. To cut a section of text from the Comments box, select a
region by holding down the left mouse button and
dragging over the desired text to highlight it. Right-click on
the highlighted text, and select Cut from the pop-up menu.
The text will be moved to the Windows clipboard where it
can be pasted into any Windows application.

Figure 3.5
Comment Window

2. To copy a section of text from the Comments box, select the
text by holding down the left mouse button and dragging
the cursor over the desired text to highlight it. Right-click on
the highlighted text, and select Copy from the pop-up
menu. The text will be copied to the Windows clipboard
where it can be pasted to any Windows application. The text
will remain in the Comments box.
3. To paste text into the Comments box, copy it first to the
clipboard. Click on the text box in the location where the text
should go. Right-click on the text box and choose Paste from
the pop-up menu. The text should appear in the Comments
box at this location.
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Deleting a Dataset or Experiment from the Experiment Window
1. Click on the dataset or experiment icon to be deleted in the Experiment window.
2. Choose Remove Dataset… from the File menu. Note that this text will be dependent on whether a dataset or experiment has been
selected. If an experiment has been selected, the entire experiment will be deleted.
3. The icon corresponding with the deleted dataset(s) will be removed from the Experiment window.

Changing the Axis Scale on a Dataset
1. View the desired dataset by clicking on the associated icon in the Experiment window.
2. Click on the data in the graph to be scaled so that it is highlighted. The data trace will become
yellow and a cursor will appear (see Figure 3.6).

Figure 3.6
Highlighted dataset

3. Right-click on the graph and choose Scaling from the pop-up menu.
4. Select and enter desired values for the new scale (see Figure 3.7).
5. To automatically scale the axes, choose Autoscale from the pop-up menu. Alternately, the
Autoscale checkbox can be checked in the Scaling form.

Zooming in on a Region of the Graph

Figure 3.7
Scaling form

1. Click on the data within the graph to highlight it. The data will become yellow and a
cursor will appear (see Figure 3.6).
2. Choose Zoom from the Chart menu.
3. Drag the mouse on the graph to graphically select the new scale axes. A box will be drawn
around the new graph (see Figure 3.8). Release the mouse button when the desired region
has been selected. It should now zoom in on the selected section.
4. The cursor will remain in Zoom mode so that this process can be repeated if further
zooming is desired. To exit this mode, click on Zoom in the Chart menu. This will return
the graph to normal cursor mode.

Figure 3.8
Zooming a region of the
graph

5. To return the chart to its original settings, click on Reset Chart in the Chart menu.
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Printing a Report of the Dataset
1. Select the dataset to be printed by clicking on the data in
the graph. The selected data trace will turn yellow and a
cursor will appear (see Figure 3.6). It does not matter which
trace is selected.
2. If two graphs are present, one can be enlarged by
double-clicking on the graph. Also, traces can be hidden by
clicking on them and choosing Hide Slice from the View
menu.
3. Select Print Preview from the File menu. A Print Preview
screen will appear (see Figure 3.9).
4. Choose Print to print the dataset or Close to cancel the
print.
5. The dataset will print as shown in the preview screen. The
printout will include the dataset name, date and time of
printing, dataset filename, date and time of data collection,
data, and comments. Printouts of data fits will include fitted
parameters.

Printing a Chart of the Dataset
1. Select a dataset to print by clicking on the data in the graph.
The data will turn yellow to indicate it has been selected (see
Figure 3.6).
2. Click on Print Chart under the Chart menu.
3. A printout of the chart will be generated with no comments
or other information included.

Figure 3.9
Print Preview screen

Exporting a Chart to Another
Windows Application
1. Highlight the graph to be printed by clicking on the data
within the graph. The selected data trace will turn yellow and
a cursor will appear (see Figure 3.6). It does not matter which
trace is selected.
2. Select Copy to Clipboard from the Chart menu. The chart
will now be available in the Windows clipboard.
3. Open the other Windows application to which you wish to
move the chart.
4. Use the Paste control in the Edit menu to import the chart
into the application.
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Working with Datasets

Working with Datasets
Having now gained a better grasp of the basic operating functions in Olis GlobalWorks, you are
ready to move on to more complex operations within the program. In this section, you will begin
working with data that you have collected. We will cover Viewing Data from a Graph, Truncating a
Dataset, Performing Mathematical Operations on a Dataset, Adding Axis Labels to a Dataset,
and Cutting, Copying, or Pasting Text into the Comments Box.
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Viewing Data from a Graph
1. To view the values of a data point within a graph, click on the
data in the graph to highlight it. The curve will become
yellow and a cursor will appear (see Figure 3.6).

Truncating a Dataset
(or Extract a Trace as a New
Dataset)
1. If the dataset is configured for the 2D view, click on the
dataset to select a trace (it is not important which trace is
selected).
2. Choose Create data Subset from the Tools menu.

Figure 4.1
Selected data parameters

2. The data will be displayed in Selected Data Parameters
located in the upper right portion of the screen (see
Figure 4.1).
3. The intensity (in this example Absorbance) for the data point
selected by the cursor is displayed in the Value column of the
grid. This value corresponds to the Z-axis of the dataset. The
X-value (Wavelength in this example) and Y-value (Time) are
displayed in this column, as well. If the dataset is
two-dimensional, the Y-axis will consist of one point. The
index column corresponds to the data point number. Note
that in most 3D datasets not all traces are displayed (only nine
are displayed). To select a specific trace for viewing, click on the
value or index, enter the number corresponding to the hidden
trace and it will appear on the graph.

3. Enter the desired data ranges for the new dataset in the
corresponding boxes on the Data Limits window (see Figure
4.3). The range can be entered either as a value (e.g.,
wavelength) or a data point index. If a 2D trace is to be
extracted, choose identical values for the limits of that axis.
For example, if a kinetic trace at 500 nm is to be extracted,
the range for that dataset axis would be 500 nm and 500 nm.
Note that if 500 nm is not an exact data point, the software will
select the closest value.
4. Click on Accept Limits to create a new dataset with the new
axis limits.

4. The cursor can be dragged along the trace to change the
datum to be displayed in the Selected Data Parameters table.
To lock the cursor on a particular trace, click on that trace
and choose Lock On Slice from the Edit menu. To release the
trace, click Lock On Slice again.
5. Note that the arrows displayed on
the toolbar are a convenient way for
moving the cursor along, one datum
at a time (see Figure 4.2). Click on a
Figure 4.2
Toolbar arrows
left or right arrow to move the cursor
though a trace, or click on the up or
down arrow to move the cursor to a new trace.
6. Alternately, the data can be viewed using the Edit Dataset
feature (see pages 20-21) or by exporting the dataset as an
ASCII type file.
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Figure 4.3
Data Limits menu
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Performing Mathematical Operations on a
Dataset(s)
1. In the Experiment window, view a dataset by clicking on the associated icon.
2. Right-click on the dataset icon, and choose Select from the pop-up menu (see Figure 4.4).
This will select the dataset for data processing. A red checkmark will appear on the icon
to indicate it has been selected. To deselect a dataset, right-click on the icon and choose
De-select.
3. Repeat this procedure for any datasets to be included in the mathematical operation.

Figure 4.4
Select (or De-select) Dataset

4. Right-click on the dataset again and choose the desired mathematical operation
under the Data Processing menu (see Figure 4.5). These options are discussed in detail on
pages 16-17.
6. A new icon will appear for the mathematically manipulated dataset and will be
generated in the Experiment window. The dataset name will be modified to reflect the
process it has undergone.

Note that if the data process involves multiple datasets, you will need to repeat the
selection procedure for the second dataset. Repeat until each dataset involved in the
process is marked with a red checkmark. The data process list will change to show
only those processes which are possible on multiple datasets.

Adding Axis Labels to a Dataset

Figure 4.5
Data Processing menu

1. Click on the dataset icon in the Experiment window.
2. Click on the data in the chart. The selected trace will turn yellow and a
cursor will appear (see Figure 3.6). It does not matter which trace is
selected.
3. Select Edit Dataset from the Edit menu.
4. The Edit Dataset window will appear containing the data in the same
format described in Appendix 1 (see Figure 4.6) For a more thorough
description of the Edit Dataset screen, see pages 20-21.
5. Edit the axis labels in the Edit Dataset form. The X and Y-axes refer to the
horizontal axes of the 3D dataset, while the Z is the vertical axis.
6. Click on Post data to GlobalWorks. A new dataset with the changed axis
labels will be created in the Experiment window with the original dataset
name plus "-Edit."
Figure 4.6
Edit Dataset menu
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Fitting a Two-Dimensional (2D)
Dataset
1. View the dataset to be fit in the Experiment window by
clicking on its associated icon.
2. Click on data in the chart to select it. The selected trace will
turn yellow and a cursor will appear (see Figure 3.6). If the
dataset is three-dimensional, one can still invoke a 2D fit on a
selected 2D trace (e.g., data at a single wavelength) by
clicking on the trace to be fit.
3. If you desire to fit only a portion of this data trace,
click on Create Data Subset from the Tools menu.
4. Enter the range of the dataset you wish to fit. Click
Accept Limits. Click on the new dataset to select it
(if it is not automatically selected).
5. Select 2D fits under the Fits menu and choose the
desired kinetic model to fit the data (see Figure 4.7).
If the model you would like to use is not there, please
contact Olis and we will consider adding it.
Depending on the Fit Model you select, you may
be asked to provide additional information
(e.g. starting parameters).
6. The results from the fit are given in the upper left
portion of the screen. These include fitted
parameters (e.g., rate constants) with error
estimates, the overall standard deviation, and the
number of iterations taken to get the fit.
7. The residuals are plotted in the upper right graph. This is a
plot of the difference between the calculated data from the
fit and the actual data. For a good fit, this plot is featureless
and only contains random noise.
8. Systematic deviations are indicative of a poor fit. This is likely
the result of an inappropriate kinetic model chosen to fit the
data. Increasing the complexity of the model may be
necessary in order to properly fit the data.
9. The data and fit are plotted in the main central graph. The
blue line is a plot of the data, while the red line contains the
calculated data.
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Figure 4.7
Fit Model menu
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Viewing Only One Scan from a
Three-Dimensional (3D) Dataset
1. Click on the scan to be viewed to select it. A cursor will
appear and the data will become yellow (see Figure 3.6).
2. Choose Hide Slice under the View menu. Alternately, you
may click on the Hide Slice toolbar icon. The curve will
disappear from view to a hidden clipboard.
3. Choose Swap Hidden/Unhidden Slices under the View
menu, or click on the corresponding icon on the toolbar. This
will cause the slice(s) on the hidden clipboard to become
visible and hide all currently visible slices.
4. To return all the scans to view, choose Unhide Slice, or click
on the Unhide Slice icon on the toolbar. This will cause all
hidden slices to become visible.

Viewing a "Movie" of the
Spectral Changes of a ThreeDimensional (3D) Dataset
1. Click on the spectral graph (left) to select it. A cursor will
appear on a yellow trace (see Figure 3.6).
2. Right-click on the graph and choose Scaling from the
pop-up menu. Change the scale, if desired, by entering new
values. Click Accept Limits. This step will prevent the movie
from auto-scaling.
3. Choose Swap Hidden/Unhidden Slice from the View menu,
or click on the Swap Hidden/Unhidden Slice icon on the
toolbar. The graph will disappear from view.

Fitting or Exporting a Kinetic
Trace from a Three-Dimensional
(3D) Dataset (Procedure for
Fitting or Exporting any 2D Trace
from a 3D Dataset)
1. Enter the 2D slice view of the dataset by choosing 2D View
from the View menu.
2. Click on the graph of spectra to select one of the scans; it
does not matter which one is selected. For the 3D kinetic
example of scans over time, click on the spectral graph (left)
if a kinetic trace at a particular wavelength is to be fit or
exported.
3. Select Dynamic Slicing from the Edit menu.
4. Drag the cursor along the trace to the desired value to fit.
The corresponding trace will be displayed in the opposite
graph. This will change as the cursor is moved. The current
value is displayed in the Selected Data Parameters table.
5. After the desired value is chosen, click on Dynamic Slicing in
the Edit menu again to turn this mode off.
6. Click on the newly generated trace to select it. The data will
become yellow and a cursor will appear when selected (see
Figure 3.6).
7. To fit the data, follow the instructions in Fitting a
Two-Dimensional (2D) Dataset (see page 31).
8. To export the data, follow the directions in Exporting a
Two-Dimensional (2D) Dataset to an ASCII Format (see
page 35).

4. Click on the right graph to highlight the kinetic trace. Note
that this could be plotted versus temperature or some other
parameter.
5. Choose Dynamic Slicing from the Edit menu or click on the
Dynamic Slicing icon on the toolbar.
6. Drag the cursor on the kinetics graph (right) to view the
changing spectra in the spectral graph (left).
7. To return the charts to their original condition, turn off
dynamic slicing by clicking on the Dynamic Slicing icon on
the toolbar and selecting Reset All Charts from the Chart
menu.
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Fitting a Three-Dimensional (3D) Kinetic Dataset Using Singular
Value Decomposition (SVD)
1. Datasets collected as scans as a function of a parameter such
as time, temperature, or concentration can and should be fit
using the Global Analysis fit in GlobalWorks. This
procedure describes fitting a kinetic dataset. A list of
recommended reading to learn more about this analysis is
given in Appendix 3.
2. Select the 3D dataset to be fit by clicking on its associated
icon in the Experiment window. A dataset must contain
between 10 and 4000 scans, each scan containing at least 10
data points, to be analyzed by this method of analysis.
3. Choose SVD from the Fits menu or click on the SVD button
to initiate the singular value decomposition (SVD) process.
4. The next screen contains the eigenvectors resulting from the
SVD analysis.
5. Choose the appropriate number of species to fit by clicking
on the number of species present. This decision is based on a
number of criteria:
i. The most important criterion is the look of the
kinetic component of the eigenvector in question.
Eigenvectors representing only noise will have a flat,
random appearance to the kinetic eigenvectors. In
this example, eigenvectors 1, 2, and 3 are significant,
while 4, 5, and 6 are not.
ii. The second most important criterion for this
evaluation is the weight percentage. This value is
shown directly below the kinetic components and is
expressed relative to the first eigenvector. A large
drop off in weight percentage in indicative of an
insignificant eigenvector. The graph in the lower
right is a log plot of weight percentage versus
eigenvector number. Deviations from a linear plot
are suggestive of significant eigenvectors. This is the
criterion the program uses when it predicts the
number of species, as indicated by the highlighted
number of species.
8. Choose the appropriate model to describe the data from the
list given on the next screen. Note that for kinetic fits, this list
will differ depending on the number of species selected.
9. The fit results, including rate constants, amplitudes, and
standard deviations, are displayed on the next screen. This
screen also contains three graphs. The left graph shows a
calculated spectrum of each kinetic component. This
displays spectra for A (red line), B (cyan line), and C (yellow
line). The right graph shows the contribution of each of these
species to the total as a function of time. Note that A (red
line) decreases as B (cyan line) increases then decreases,
followed by the formation of C (yellow line). The total
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calculated eigenvector contribution is given by the white
line. Finally, the blue line shows the experimental data. The
third graph (top) is a plot of the residuals, which are obtained
by subtracting the experimental data from the total
calculated contribution.
10. A good fit shows a residuals plot which is featureless (i.e.,
linear around zero with only random noise). An example of
a bad kinetic fit is one in which the residual plot is not flat
and featureless, rather it has significant shape. This is an
indication that an incorrect number of rates (incorrect
number of species) has been chosen for the fit. A second
criterion is the overall standard deviation. This value should
be as low as possible. Finally, the calculated spectra
themselves can be evaluated. Do they look real? For
example, an absorbance spectrum (not a difference
spectrum) cannot be negative. Therefore, a global fit which
results in negative spectra likely is not correct, even if the
kinetic fit appears to be good. Spectra can also be used to
differentiate models that appear to fit. An example of a
good kinetic, but bad spectral, fit is one where the residuals
are flat and featureless, but impossible spectra (negative
absorbance) are required to fit this model. Thus, this model
is unlikely to be correct, but likely contains the correct
number of chemical species.
11. To repeat a fit with a different model, click on the Global Fit
Model tab in the Global Fit Results page and choose the
new model to use.
12. To repeat a fit using a different number of species, click on
the Factor Analysis tab and choose the new number of
species and the appropriate model.
13. To add a comment, click on the tab labeled Comment. Add
text to the text window.
14. To view spectral information, such as peak wavelengths,
choose the Selected Data tab, click on the appropriate
graph, and move the cursor to the desired position. The
information on that datum is given in the table.
15. To display the model in matrix form, click on the Matrix tab.
A description of this display is located in Appendix 5.
16. SVD results can be saved by selecting Save As... from the
File menu.
17. In addition, individual traces can be exported by
right-clicking on them and choosing Save as ASCII from
the pop-up menu to save as a two column ASCII (tab
delimited) file.
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Fitting a Three-Dimensional (3D) Equilibrium Dataset Using
Singular Value Decomposition (SVD)
1. Global fitting can be used to fit spectra collected as function
of temperature or concentration. In this case, the fitting is
quite similar to the kinetic fits. In fact, the SVD steps are
identical.
2. The image to the right is an example of a series of circular
dichroism spectra of the protein hen egg white lysozyme
recorded at increasing temperatures (see Figure 4.8).
3. The same data can be shown in split screen mode by
clicking the Show data in 2D button at the top of the
screen (indicated by the small green graph displayed on
x and y-axes).
4. Choose SVD from the Fits menu or click on the SVD button
on the toolbar to initiate the SVD process.
5. The resulting SVD eigenvectors are displayed as shown (see
Figure 4.9). Note that only the first two eigenvectors appear
to be significant. This is indicated by the non-random look
of the thermal data in the second eigenvector compared to
that of the third eigenvector. Also contributing to this
observation are the weight percent values of the
eigenvectors which are plotted on the small graph. Note
that a sharp deviation occurs between eigenvectors two and
three. For more information on what these eigenvectors
represent, please see Appendix 3.

Figure 4.8
S3D data display
(lyso2050.ols sample data)

6. Click on the button labeled 2 to fit two eigenvectors. A list
of equilibrium models will appear. In this case, a simple
native to unfolding model (NQU) is chosen. Click on
Fit Data.
7. A message box will appear prompting for starting values.
Typical starting values are given in the example. Click
Accept to begin the fit.

Figure 4.9
SVD screenshot
(lyso2050.ols sample data)

8. The results page presents the fitted parameters in the upper
left panel. These include enthalpy and melting temperatures.
Also included are the standard deviations for the fit, which is
the standard deviation of the residuals, and the overall standard deviation, which includes the spectral data, as well. The graph
on the lower left contains the calculated spectra for all species involved in the fit. In this case, the blue spectrum is the folded
lysozyme and the red represents the unfolded species. Their contributions at each temperature are plotted on the lower right
graph. Also included are the calculated total contribution (purple) and the experimental data (green). Finally, the residuals (the
difference between the calculated and experimental total contributions) are plotted in the upper right-hand graph.
9. The fit results can be saved by choosing Save Dataset… from the File menu.
10. Any of the traces can be exported by following the instructions in the Exporting a Two-Dimensional (2D) Dataset to an ASCII
Format section (see page 35).
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Exporting a Two-Dimensional
(2D) Dataset to an ASCII Format
1. Select a dataset to be exported by clicking on the associated
icon in the Experiment window.
2. Right-click on the chart and select Save As ASCII from the
pop-up menu.
3. Enter the filename when prompted.
4. A two column, tab delimited ASCII text file will be created
with this filename. This file can be opened directly into most,
if not all, scientific analysis programs including GlobalWorks.
5. Alternately, data can be exported directly into Excel by
selecting Export Data to Excel under the right-click menu
(see Figure 4.10).

Exporting a Three-Dimensional
(3D) Dataset to Excel

Importing a Dataset from an
ASCII Format

1. In the 2D view, select a dataset to be exported by clicking on
the associated icon in the Experiment window.

1. Verify that the format of the dataset to be imported exactly
matches that described in Appendix 1.

2. Right-click on the dataset and select Export Data to Excel
from the menu.

2. GlobalWorks also reads a number of instrument data files
directly. A list of these can be found in Appendix 1. Olis is
continuously adding file types to this list, so check the Olis
website for an updated list. The file types read by your system
are listed in the Open Dataset form accessed from the File
menu. Click on the drop-down box labeled Files of Type for
the list of file types.

3. The dataset will be opened directly into Excel (see Figure
4.10). Note that Excel must be installed on the computer to use
this option.
4. Data will be formatted as is shown in the Edit Dataset
window, which is accessed by choosing Edit Dataset from
the Edit menu.
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Figure 4.10
Data exported to Excel

3. To import ASCII data, choose Import Data from the File
menu. The data will be read into GlobalWorks. No axis labels
or other information about the file will be available. To
change the axis labels, see Changing the Axis Scale on a
Dataset (see page 26).
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Smoothing a Two-Dimensional (2D) Scan
1. In the Experiment window, select a dataset by clicking on the
associated icon.
2. Right-click on the dataset icon, and choose Select from the
pop-up menu (see Figure 4.4). This will select the dataset for
data processing. A red checkmark will appear on the icon to
indicate it has been selected. To deselect a dataset,
right-click on the icon and
choose De-select.
3. Right-click on the selected
dataset, select Data Processing
from the pop-up menu (see
Figure 4.5). Then, select
Processing Single Dataset and
choose the Digital Filter option
from the drop-down list.
Smoothing window will appear
(see Figure 4.11).

3. Choose Reconstruct 3D from SVD Data from the Tools
menu. A new 3D dataset will be generated from the top six
eigenvectors. An icon for this dataset is displayed in the
Experiment window. This dataset will differ from the original
dataset only in the noise level. As long as all of the data are
contained in these eigenvectors (i.e., it contains more than
six species), no distortion of the data occurs because only
noise is contained in the lower eigenvectors.

Smoothing a Time Trace with a Digital RC
Filter
1. The purpose of the RC Filter data process is to allow for
smoothing time data (i.e., assays) using a digital simulation of
an RC filter. To employ this filter, first view the dataset to be
smoothed by clicking on it in the Experiment window.

Figure 4.11
Smoothing menu

4. Choose the degree of smoothing (3-25 points per average).
Click Accept. The smoothing algorithm is the
Savitzsky-Golay algorithm. The degree of smoothing is the
number of points to be included in the 'moving average.'
Increasing this number increases the severity of the smooth.
Care must be made to avoid over-smoothing data, which
results in distorted spectral features, rather than just
decreased noise. To test if a dataset has been over-smoothed,
subtract the unsmoothed dataset from the smoothed one, as
described in the Perform Mathematic Operations on a Dataset.
The resulting spectrum should be featureless and only
contain random noise. If systematic deviations are present,
reduce the degree of smoothing.
5. A newly smoothed dataset will be generated in the
Experiment window. The name will by default be '[the
original data file name]-smoothed.'

Smoothing a Three-Dimensional (3D)
Dataset Using Singular Value
Decomposition (SVD)

2. Right-click on the dataset icon in the Experiment window and
choose Select from the pop-up menu that appears (see
Figure 4.4). A red checkmark
will appear on the icon
indicating that the dataset
has been selected for data
processing.
3. Right-click on the selected
dataset and choose Data
Processing from the pop-up
menu (see Figure 4.5). Then,
choose Processing Single
Dataset and select RC Filter
from the drop-down list.
Figure 4.12
RC Filter menu
4. Choose the appropriate time
constant for the filter when
prompted (see Figure 4.12). Note that it is possible to
over-filter and distort data using this filter. Care must be
taken to choose a time constant that provides a sufficient
degree of smoothing, but does not distort the data. An
excellent test of distortion is subtracting the smoothed
dataset from the original dataset (see Performing
Mathematical Operations on a Dataset(s)). The difference
should be featureless and only contain
random noise.

1. Click on the desired dataset in the Experiment window.
2. Select SVD from the Fits menu or click on the SVD icon to
generate the SVD eigenvectors.

5. Clicking Accept invokes a digital RC filter. A new filtered
dataset will appear in the Experiment window.
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Creating a Three-Dimensional (3D)
Dataset from Two-Dimensional (2D)
Datasets
1. Open all desired sets of data by choosing Open Dataset
from the File menu or by opening an experiment containing
multiple datasets.

Figure 4.13
Edit Dataset menu

2. Move to the first dataset to be viewed by selecting the
appropriate dataset from within the Experiment window.
3. Select Copy Slice under Edit menu.
4. Repeat steps 1 through 3 until all desired datasets, except
the last, have been copied. Each step will add the current
dataset to the copy clipboard.

Viewing More than One Two-Dimensional
(2D) Dataset on a Single Graph

5. Select the last dataset to view by clicking in the data.
6. Select Paste Slice under the Edit menu.
7. If the datasets have identical axis units for the abscissa and
the ordinate (termed X- and Z-axes by the software) and
identical X-axis values, a new dataset will be created in the
Experiment window, including all the copied datasets. To view
the dataset in the split screen mode, select 2D View from the
View menu, and double-click on the spectral (left) graph.
8. To add axis information for the Y-axis, click on the newly
created dataset to highlight it, and select Edit Dataset from
the Edit menu.

1. Open all desired sets of data by choosing Open Dataset
from the File menu or opening an experiment containing
multiple datasets.
2. Move to the first dataset to be viewed by clicking on the
associated icon in the Experiment window.
3. In the 2D view, select the data by clicking on the data on the
graph.
4. Select Copy Slice under the Edit menu.

9. The Edit Dataset screen will appear (see Figure 4.13).

5. Repeat steps a through d until all desired datasets, except
the last, have been copied. Each step will add the current
dataset to the copy clipboard.

10. Enter the new axis title and units in the Y-axis frame.

6. Select the last dataset to view by clicking in the data.

11. Click on the Edit Axis Data button in the Y-axis frame. The
Edit Dataset screen will change to allow access to the Y-axis
data.

7. Select Paste Slice under the Edit menu

12. Enter the data for the new Y-axis. Click on the Save axis
data button. The screen will return to its original
configuration.
13. Click on the Post data to GlobalWorks button to create a
new icon in the Experiment window. This dataset can be
processed or saved as a typical 3D dataset.

8. If the datasets have identical axis units for the abscissa and
the ordinate (termed X- and Z-axes by the software) and
identical X-axis values, a new dataset will be created in the
Experiment window, including all the copied datasets. To view
the dataset in the split screen mode select 2D View from the
View menu and double-click on the spectral (left) graph.
9. If a dataset cannot be created, data will be viewed together,
but will not be able to be saved as a single dataset.
10. To hide a slice from view (and from the printer), select it and
choose Hide Slice from within the View menu.

Note that an alternative method for creating a 3D dataset is to
create the dataset in Excel and import the 3D ASCII dataset.
This is described in Importing a Dataset from an ASCII
Format (see page 35).
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11. To switch between hidden slices and viewed slices, select
Swap Hidden/Unhidden Slices under the View menu.
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Using Peak Finder to Locate Peaks in a Spectrum
1. In the Experiment window, select a dataset by clicking on the associated
icon.
2. Right-click on the dataset icon, and choose Select from the pop-up menu
(see Figure 4.4). This will select the dataset for data processing. A red
checkmark will appear on the icon to indicate it has been selected. To
unselect a dataset, right-click on the icon and choose De-select.
3. Right-click again on the dataset icon and choose Data Processing from
the drop-down menu (see Figure 4.5). Then, select Processing Single
Dataset and choose Peak Finder from the list of processes. Note that if
only Processing Multiple Datasets is available, choose De-select All from
the menu and select the dataset again.
4. The Peak Fitting form will appear.

Figure 4.14
Peak Finder window

5. Choose the appropriate Average Points and Slope Threshold and press Accept to perform an initial analysis. See page 19 for a
detailed description of these parameters.
6. Change the Average Points and the Slope Threshold, if appropriate, and click on Accept again until the desired peak sensitivity is
achieved.
7. The peak positions and intensities are displayed on the graph and in the Peak Results table.
8. The graph can be printed by choosing the Print option on the menu bar.
9. When peak fitting has been completed, click on Done. A dataset will be created in which the peak positions and peak finder
parameters are added to the Comments box. Note that it might be necessary to scroll down in the Comments box to view the Peak
Finder data.

Changing the Type of Singular Value Decomposition (SVD) Fit
1. There are two types of SVD fits available using GlobalWorks.
Golub-Reinsch is the original SVD algorithm used in the Olis
software, and Matheson is a more recent improvement which
uses wavelength compression. Appendix 3 contains a reading
list describing both techniques. The Golub-Reinsch algorithm
is best for smaller datasets (<10,000 total data points) and the
Matheson for larger ones. This is the default Olis GlobalWorks
setting. However, this can be changed using the Options menu.
2. The type of SVD fit can be changed by clicking on the Options
selection under the Tools menu.
3. Click on the SVD Type tab.
4. Choose either Golub-Reinsch, Matheson, or Default. If Default is
chosen, the selection will be made dynamically based on the
size of the dataset. Default is the recommended type.

Figure 4.15
SVD screen
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Convert Among Circular Dichroism Units

Perform Protein Secondary Structure Fits

1. In the Experiment window, select a dataset by clicking on the
associated icon.

1. Open the CD spectrum to be analyzed and navigate to it by
clicking on the associated icon in the Experiment window.

2. Right-click on the dataset icon, and choose Select from the
pop-up menu (see Figure 4.4). This will select the dataset for
data processing. A red checkmark will appear on the icon to
indicate it has been selected. To unselect a dataset,
right-click on the icon and choose De-select.

2. Click on the spectrum to highlight it.

3. Right-click again on the selected dataset and choose Data
Processing from the pop-up menu (see Figure 4.5). Then,
choose Processing Single Dataset and select Convert CD
Units from the list. If only Processing Multiple Datasets is
available, choose De-select All from the menu and select the
dataset again.

3. Choose the desired protein secondary structure algorithm
from the Secondary Fit Structures drop-down in the Fits
menu. See Appendix 4 for detailed information on the
spectral format required to fit using these algorithms.
4. Once the fit has been chosen, the Basis Set Options (basis
spectra) window appears (see Figure 4.17).

4. The CD Unit Conversion window will appear (see Figure 4.16).

Figure 4.17
Basis Set Options window

Figure 4.16
CD Unit Conversion window

5. The current CD units will be displayed in the box above.
Choose the units to which the current units should be
converted. The conversion may require concentration,
molecular weight, and pathlength information to be
inputted. Note that for proteins, the molecular weight is not
the total molecular weight, but the average molecular
weight of its amino acids (MW/# of amino acids).
6. Click OK and a new dataset will be created with the new CD
units.

5. Choose the appropriate basis set using the protein state
(soluble, denatured, etc.), suspected secondary structures,
and wavelength range as criteria. It may be advisable to try
multiple basis sets, if necessary. If one basis set will be
continuously used, then check the Don't show again box. This
will skip this prompt for future fits. To return to this screen,
select Show Basis Table for Each Fit from the Fits menu. For
more detailed information on the basis sets, see Appendix 4.
6. If the wavelength range of the dataset is outside that of the
basis set, a message will appear indicating that to perform
the fit, data from the original dataset must be trimmed. This
will not affect the original data, only the fitted result.
7. The results of the fit are displayed in tabular and graphical
form. The secondary structure composition is given in the
upper left region of the display. Both the original data and
the calculated data are presented on the main graph and the
residuals (difference between original and calculated data)
given in the upper right corner.
8. This page can be saved by choosing Save Dataset… from
the File menu.
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Convert a Single Detector Trace to
Absorbance
1. Absorbance data are collected as a single detector signal.
The reference signal, which is necessary for the absorbance
calculation, is assumed to be equal to the value of the signal
before (or after) the reaction has occurred. This data process
allows for this calculation to be performed after the data
have been collected. To perform this process, first view the
dataset by clicking on the icon in the Experiment window.
2. Right-click on the icon in the Experiment window and choose
Select to select the dataset for processing (see Figure 4.4). A
red checkmark will appear on the icon indicating the
dataset has been selected.
3. Right-click on the selected dataset again and choose Data
Processing from the drop-down menu (see Figure 4.5). Select
Processing Single Dataset and choose Convert Volts to
Absorbance from the list. The Convert Volts to Absorbance
window will appear (see Figure 4.18).
4. Enter the region of the dataset from which the reference will
be derived. The reference value used will be the average of
this region of data.

correction file. GlobalWorks provides the means to correct
spectra using this file, which is an array of sensitivity factors
versus wavelength and termed S(O).
2. Generate S(O) using one of three methods. See Lakowicz, J. R.
(1999) Principles of Fluorescence Spectroscopy, Second
Edition, Kluwer Academic/Plenum Publishers, New York.
pp. 51-52 for more detailed information on correcting emission
spectra.
a. Known Emission Spectra- A normalized spectrum of
a known standard is collected under identical
conditions to the standard. A set of known spectra
are provided in the Demo Data folder of Olis
GlobalWorks. A ratio of the known spectrum to the
collected spectrum generates S(O).
b. Standard Lamp Ratio- The known lamp spectrum
provided with the normalized spectrum of the lamp.
This dataset serves as S(O).
c. Quantum Counter and Scatterer- Collect an
excitation spectrum using the quantum counter in
the sample compartment. Place an MgO scatterer in
the sample compartment and collect a synchronous
scan over the same range. Divide the lamp
quantum counter spectrum by the scatter spectrum
to obtain S(O).
3. Click on the first icon of the dataset(s) to be corrected in the
Experiment window.

Figure 4.18
Convert Volts to Absorbance window

4. Right-click on the icon again and choose Select from the
pop-up menu (see Figure 4.4). A red checkmark will appear on
the icon to indicate that it has been selected for data
processing.
5. Repeat steps 3 and 4 until all intended spectra are selected.

5. A new dataset will be created which has been converted to
absorbance.

Correct a Fluorescence Scan for
Instrumental Sensitivities
1. In order to directly compare a fluorescence emission scan
with another from a different instrument, it must be
corrected for differences in instrument sensitivities. These
include light source intensity, monochromator efficiency, and
PMT sensitivity as a function of changing wavelength. The
source and excitation monochromator are routinely
corrected using a quantum counter. The emission
monochromator and detector are corrected using a

6. Right-click on one of the selected dataset icons and choose
Data Processing from the pop-up menu (see Figure 4.5).
Then, select Processing Multiple Data Sets and choose
either Correct Fluorescence Scan or Corrected Scans from
the drop-down menu. Note that this menu will differ
depending on whether one or more datasets have been
selected.
7. Choose the appropriate S(O) for the spectral range of the
datasets. Note that the range of the correction file must be
equal or outside of the datasets to be corrected. Data
spacing is not important.
8. A new dataset will be created for each uncorrected dataset.
The dataset name will be appended with "-corrected."
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Take the Derivative of a Two-Dimensional (2D) Dataset
1. View the dataset to be processed by clicking on the icon in the Experiment window.
2. Right-click on the icon and choose Select from the pop-up menu (see Figure 4.4). A red
checkmark will appear on the icon indicating that the dataset has been selected.
3. Right-click on the selected dataset icon and choose Data Processing from the pop-up
menu (see Figure 4.5). Then, select Processing Multiple Data Sets and choose Derivative
from the drop-down menu.
4. Choose the derivative order from the window that appears (see Figure 4.19).
5. Click on Accept to calculate the derivative. The resulting dataset will be appended
with '-derivative.'

Figure 4.19
Derivative window

Perform Fast Fourier Transform of a Two-Dimensional (2D) Dataset
1. View the dataset to be transformed by clicking on its icon in the Experiment window.
2. Right-click on the dataset to be transformed and choose Select from the pop-up menu (see Figure 4.4). A red checkmark will
appear on the icon indicating that it has been selected.
3. Right-click on the selected dataset icon and choose Data Processing from the pop-up menu (see Figure 4.5). Then, select
Processing Multiple Data Sets and choose Fourier Transform from the drop-down menu.
4. On the Fourier Transform pop-up, choose the method to convert the data to one that contains a number of data points equal to
a factor of two. This can be accomplished by truncating the beginning or end of the dataset. In addition, the data can be
interpolated to an appropriate number of data points. Choose the number of data points in the pull-down box. One can also
choose to exclude the zero frequency peak from the Fourier Transform results.
5. The resulting transformed dataset will be added to the Experiment window and the name will be amended with
‘-Fourier Transform.’
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Integrate Under a
Peak in a Spectrum
1. View the dataset to be
integrated by clicking on
the icon in the Experiment
window.
2. Right-click on the dataset
icon and choose Select
from the pop-up menu
(see Figure 4.4). A red c
heckmark will appear on
the icon to indicate that it
has been selected.
3. Right-click on the selected
dataset icon and choose
Data Processing from the
pop-up menu (see Figure
4.5). Then, select
Processing Multiple Data
Sets and choose Integration
from the drop-down menu.

Figure 4.20
Integration window

4. The Integration screen will appear (see Figure 4.20). Choose the range to integrate by clicking the graph on the first endpoint.
The current data point position is displayed in the boxes labeled Point (index) and X-val.
5. After clicking, a label will appear on the graph indicating the position from which to start integrating. The index value will be
displayed in the box labeled Start Index.
6. Click on the graph at the point to end the integration. Note that, again, the current position is shown in the displays labeled
Point and X-val. Once the data range has been chosen, the results are visually displayed on the graph. The tabular results are
shown in the Integration results box. The results are reported by the Dropline method, in which the area relative to the zero
intensity line is determined (displayed as red + blue). The Trapezoidal area is the area from the calculated baseline to the zero
line (displayed as blue). Finally the Tangent area is reported. This is the area between the curve and the calculated baseline
(displayed as red). To repeat the integration with a different data range, click on Do Again. The previous integration results will
be stored in the Integration results box.
7. Click Done when finished. This will create a dataset for each integration calculation performed. The integration results are
added to the Comment section. The results dataset may be printed or saved as a permanent record.
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Interpolate a New Axis for a Dataset
1. View the desired dataset by clicking on the associated icon in the Experiment window.
2. Right-click on the dataset icon and choose Select from the pop-up menu (see Figure 4.4). A red checkmark will appear on the
icon to indicate that it has been selected.
3. Right-click on the dataset icon again and choose Interpolate from the list of single dataset data processes (see Figure 4.5).
4. The Interpolate screen will appear allowing the option to create a new axis or use an existing one. Create a new linear axis by
clicking on Generate and entering in the axis range. The entered values must be inside the Available Range.
5. To match an existing dataset, choose Use another Dataset under New X-Axis on the Interpolate pop-up window. Choose the
dataset from the Open screen. Note that the X-axis of the chosen dataset must be within the Available Range.
6. A dataset with an X-axis matching the parameters given will be created and '-interpolated' will be added to the dataset name.

Average a Two-Dimensional (2D) Dataset to One Value
1. View the desired dataset by clicking on its icon in the Experiment window.
2. Right-click on the dataset icon and choose Select from the pop-up menu (see Figure 4.4). A red checkmark will appear
indicating that the dataset has been selected.
3. Right-click on the selected dataset icon and choose Data Processing from the pop-up menu (see Figure 4.5). Then, select
Processing Multiple Data Sets and choose Average Points from the drop-down menu.
4. The average value of the dataset will be added to the Comment box.

Interchange the X and Y-Axes in a Three-Dimensional (3D) Dataset
1. This example demonstrates the axis nomenclature used by GlobalWorks. In this example, the X-axis is Wavelength, the Y-axis is
Time, and the Z-axis is Absorbance. It may be desirable to exchange the X and Y-axes. This may be necessary to use singular
value decomposition, which assumes that the X-axis is wavelength.
2. View the desired dataset by clicking on the associated icon in the Experiment window.
3. Right-click on the dataset icon and choose Select from the pop-up menu (see Figure 4.4). A red checkmark will appear on the
icon indicating that the dataset has been selected for data processing.
4. Right-click on the selected dataset icon and choose Data Processing from the pop-up menu (see Figure 4.5). Then, select
Processing Multiple Data Sets and choose Swap Axes from the drop-down menu.
5. A new dataset will be created in which the X and Y-axes have been interchanged. The dataset name will be appended with
'-swapped."
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Appendix 1
Importing and Exporting Data into GlobalWorks
Producing Compatible ASCII Files

Creating an ASCII dataset in Excel

GlobalWorks can import ASCII text files, provided they are in
the proper ASCII file format. This format (Format 1)
accommodates both two and three-dimensional data files. An
example of a data file in this format is shown here. The file may
contain any number of columns, each comma-delimited.

To import a dataset into GlobalWorks, an ASCII text file of the
above format must be created. Excel is a good tool to use for
this. Create the data in Format 1 by entering, pasting, or using a
formula to give the format as described above.

In the 3D example shown, the first column (in green) contains
the X-axis data, except for the value in the first row (shown in
red), which serves as a place holder and must be zero. The first
row serves as headers for subsequent columns (blue) and
contains the Y-data, with each value corresponding to a
column of data (white).
Each value in the data region is associated with an X-axis value
(as given by the row) and a Y-axis value (as given by the
column). Thus, for a 3D file to be read by GlobalWorks, all
columns must share one X-axis, which precludes data with
different X-axes from being incorporated into one 3D dataset.
In the two-dimensional dataset, the same format is used: the
first row contains the zero placeholder and the Y-value. If this
dataset is not to be included later as a 3-dimensional dataset,
the Y-value can be any value. The next row contains the X-axis
value followed by the associated value (Z-value).
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In the case of Excel, each cell represents a value {screen shot:
Excel Dataset.bmp}. If there are questions about this format,
see the Exporting Data from GlobalWorks section of this
document and export one of the demo datasets to Excel (see
page 35). This will give an example of the proper format in
Excel.
Save the Excel dataset as a 'Comma Delimited Values' (*.csv)
dataset by choosing this as the Save as type option after
selecting Save As… from the File menu. Choose OK when the
Excel message appears stating that the file type does not
support multiple worksheets. This indicates that *.csv files can
only be made from single spreadsheets. Click on Yes to the
question about features not being supported by this file
format. This indicates that the format does not support Excel
features such as the use of formulae to describe data. A file will
be created by Excel with the extension *.csv. This file contains
the data saved with a comma separating each value.
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Importing Data to GlobalWorks

Exporting Data from GlobalWorks

To import the file into GlobalWorks, choose Import Data from
the GlobalWorks File menu. Choose the 'AP 'CSV' data file
(*.csv) from the list in the Files of Type drop-down box. Data will
then be opened into GlobalWorks.

Exporting data from GlobalWorks creates an ASCII text file of
one of the two formats described above. To export a
two-dimensional file dataset in Format 2 from GlobalWorks,
select the data by clicking on the dataset in the Experiment
window and then click on the data in the graph. Select a
dataset to be exported by clicking on the associated icon in
the Experiment window.

The imported data will not contain axis labels. To add these,
click on the dataset icon in the Experiment window.
Click on the data in the chart. The selected trace will turn
yellow and a cursor will appear (see Figure 3.6). It does not
matter which trace is selected. Select Edit Dataset from the
Edit menu.
Edit the axis labels in the Edit Dataset form. The X and Y-axes
refer to the horizontal axes of the 3D dataset while the Z is the
vertical axis. Click on Post data to GlobalWorks.
A new dataset with the changed axis labels will be created in
the Experiment window with the original dataset name plus
"-Edit." If the data were imported with reversed axes (i.e., the
intended X-axis data is contained in the Y-axis), the dataset can
be "swapped" using the Swap data data process.
Data can also be imported into Olis GlobalWorks directly from
number of different instrument file formats. A complete list of
files that are directly compatible with GlobalWorks can be
found on the Olis website (www.olisweb.com). In addition, a list
of readable file formats is available in GlobalWorks. To view this
list, choose Open Dataset from the File menu, and click on the
drop-down menu associated with Files of Type on the File
Open window. This list contains all files that GlobalWorks can
read without modification.

Click on the data to highlight it.
Right-click on the chart and select Save as ASCII from the
drop-down list.
Enter the filename when prompted. A two column, tab
delimited ASCII text file will be created with this filename. This
file (Format 2) can be opened directly into most, if not all,
scientific analysis programs including GlobalWorks.
A three-dimensional file must be exported using Excel in the
following manner. This will export a dataset to Excel in Format
1. Note that Excel is limited to 65,536 rows and 256 columns. If
the dataset to be exported exceeds 256 columns, GlobalWorks
will export the data with the X and Y-axes reversed from the
format described above. If the number of either rows or
columns exceeds 65,536, then data cannot be exported
without being truncated prior to this step. Select a dataset to
be exported by clicking on the associated icon in the
Experiment window. Right-click on the dataset and select
Export to ASCII from the menu. The dataset will be opened
directly into Excel. Note that Excel must be installed on the
computer to use this option. Data will be formatted as is shown
in the Edit Dataset window (Format 1), which is accessed by
choosing Edit Dataset from the Edit menu.

Included on this list is Two Column ASCII. This format (Format 2)
differs from the file format described above and consists of two
columns; the first being the X-axis data and the second being
the associated values (termed Z-axis in the GlobalWorks
software). These data can be tab or comma delimited. Note
that no information about the Y-axis is incorporated into this
format. A three-dimensional file can be imported, however,
using this format. If multiple scans are presented in the format
shown below, such that the X-values are repeating,
GlobalWorks will recognize this file as a multiple scan file and
plot the repeated scans as a function of scan number. The
equivalent dataset is shown in Format 2 for comparison. Axis
values for the Y-axis can be added using the Edit Dataset
feature.

46

Appendices

Appendix 2
Olis Dataset File Specification version 1.0
Syntax
Structure of the Olis dataset file (later in the document referred
as “file”) resembles structure of XML documents. Data elements
are enclosed in a pair of opening and closing tags. Each tag
and data will start on a new line as follows:
<Name>
Absorbance
</Name>

Logical structure of the data file is presented on the figure
below:
Olis Dataset File

Prolog

DataGroup

Because parsing of the file relies on angle bracket characters
(<>), use of these characters is reserved for tags only.

Dataset

Note that element indentation shown in examples in the rest of
this document is used for illustration purposes only.

Dataset

Data elements can be nested (i.e. embedded one within
another). Element nesting sets up parent /child relationship.
Every child element resides completely within its parent
element.
<Parent>
<Child1>
data here
</Child1>
<Child2>
data here
</Child2>
</Parent>
Data of all elements other than BinData, are written in a file as
strings of ASCII characters. Data of BinData elements are
written as a binary array of bytes. Each 8 bytes of the binary
array represent a one double-precision floating-point value.
Therefore the size of the binary array is NumberOfPoints * 8
bytes. For two-dimensional arrays, data layout follows
row-major form used by SafeArrays. This means that moving to
next array element increments the last index. For example, if a
two-dimensional array (e.g. Data(i,j)) is written in such
one-dimensional binary byte array form, moving to the next 8
byte element of the binary array increments last index of the
original two-dimensional array (i.e. Data(i,j+1)). After the last
element of the binary array the combination of carriage return
and linefeed characters (ANSI characters 13 and 10) is written.
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The first structural element in a file is a mandatory prolog that
identifies the type of file as Olis dataset and its specification
version:
<Olis dataset version 1.0>
Next structural element is DataGroup. It contains one or more
Datasets. Datasets are usually grouped when there is a
relationship among them, for example they compose a result
of SVD analysis or Global fit.
DataGroup required elements:
Name
-arbitrary name
Dataset
-at least one Dataset must be present
Dataset element describes a single set of Z data as a function
of X (2d data) or both X and Y (3d data).
Dataset required elements:
Name
-arbitrary name
Type
-designates origin of data (collected
by an instrument; created as a result
of SVD analysis, fitting, etc.); Data
collected by instruments is
designated by constant 3301.
XAxis
-element describing X axis
YAxis
-element describing Y axis
ZAxis
-element describing Z axis;
Note: XAxis and YAxis elements must
precede the ZAxis element

Appendices

XAxis, YAxis required elements:
Name
-name of axis data
Units
-units of axis data
IsLinear
-True if data is distributed in a linear
manner along this axis;
False if not linear
Number of Points
-number of data points
Start
-value of the first axis point; required
only if IsLinear = True
Step
-step between two consecutive axis
points; required only if Is
Linear = True; For linear point
distribution one can compute values
along the axis using Number of
Points, Start and Step values.
BinData
-contains values of all axis points;
data is written in a binary form;
required only if IsLinear = False;
ZAxis required elements:
Name
Units
BinData

-name of axis data
-units of axis data
-contains values of all points; data is
written in a binary form;

Important: Some files may contain additional elements.
Specification of these elements has not been finalized.
Therefore, these elements should not be used for data import.
Using such elements may cause errors.
Following example shows a file, which contains a single 3d
dataset (Absorbance as a function of Wavelength and Time).
The example shows all required elements. Note that
indentation in the example is shown for illustration purposes
only. Note that X Axis has a linear data distribution and Y Axis
has a non-linear distribution.
<Olis dataset version 1.0>
<DataGroup>
<Name>
GroupName
</Name>
<Dataset>
<Name>
DatasetName
</Name>
<Type>
3301
</Type>
<XAxis>

<Name>
Wavelength
</Name>
<Units>
nm
</Units>
<IsLinear>
True
</IsLinear>
<Number of Points>
201
</Number of Points>
<Start>
400
</Start>
<Step>
2
</Step>
</XAxis>
<YAxis>
<Name>
Time
</Name>
<Units>
sec
</Units>
<IsLinear>
False
</IsLinear>
<Number of Points>
150
</Number of Points>
<BinData>
…..binary data here
</BinData>
</YAxis>
<ZAxis>
<Name>
Absorbance
</Name>
<Units>
</Units>
<BinData>
….. binary data here
</BinData>
</ZAxis>
</Dataset>
</DataGroup>
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Appendix 4
GlobalWorks supports the use of four commonly used
secondary structure fitting algorithms. Far-UV circular
dichroism spectra of proteins and peptides are extremely
sensitive to protein secondary structure. Many empirical
methods have been developed to use far-UV circular dichroism
spectra to quantify protein secondary structure. These
algorithms were not developed by Olis, and we have
reproduced them faithfully from their original sources. There
are several reviews available in the literature which compares
these fits [1-4]. All of these fits are available under the Fits
menu of GlobalWorks.
Compton: The Compton fit, which originates from the
laboratory of Curtis Johnson [5], is the original secondary
structure fit provided with the Olis software. This rather simple
approach uses inverse spectra derived by using singular value
decomposition (SVD) from CD spectra of proteins with known
X-ray crystal structures. The fraction of each component is
obtained from a dot product of the inverse spectrum with the
CD spectrum of the unknown protein. This algorithm differs
from the others in that it requires data spaced at one point
every 2 nm, must start at 260 nm, and end at 184-178 nm.
SELCON3: Developed in the laboratory of R. W. Woody [6],
SELCON incorporates the self-consistent method in which
successive iterations achieve an rms noise of 0.0025 to predict
secondary structure. This method is termed self consistent for
this reason. The algorithm first assigns an initial guess at the
composition using the SVD method of Hennessey and Johnson
[7]. Then, in the second step, the initial starting compositions
are iterated using the SVD calculation until a convergent
solution is obtained. The results are then constrained to the
sum of compositions being close to 1 and no composition less
than -0.05. Finally, the results are further constrained by the
helix limit theorem as described by Hennessey and Johnson
[7].
CONTINLL: The CONTIN algorithm was originally developed
by Provencher and Glockner [8]. In this algorithm, ridge
regression [9] is used to fit a linear combination of spectra of
known composition to match a spectrum of unknown
composition. CONTIN3 uses this algorithm, with a locally
linearized model [10]. In this model, basis set proteins are
screened for those with the lowest rms deviation from the
spectrum of unknown composition. Thus, only spectra which
closely match the unknown spectrum are used.
CDSSTR: CDSSTR is from the laboratory of Robert Woody [11].
This algorithm uses all possible combinations of a fixed
number of proteins in the reference set. This method is
generally the most accurate of the algorithms in GlobalWorks,
but can take a long time to perform all the necessary
calculations.

Cluster: The cluster program was developed by Sreerama, et.
al.[12]. This approach is to create a basis set of proteins of
similar tertiary structure and is intended to improve the
secondary structure fit by more closely matching the basis sets
to the protein of interest. To employ the cluster approach,
choose this basis set 11. This will create a custom clustered
basis set based on the predicted tertiary structure of the
unknown protein.

Basis sets
All of the secondary structure fits require a basis set, which
contains CD spectra of proteins of known secondary structure.
Secondary structures of these model proteins were obtained
from X-ray crystal structures. These basis sets are described in
detail in the literature [11-16]. The rule of thumb for selecting a
basis set is to choose the largest appropriate set for your
protein. Make sure to match the protein type (soluble,
denatured, or membrane) as well as include the wavelength
range of the spectrum to be analyzed (e.g., a spectrum from
180-260 nm should be analyzed with a basis set range of
178-260 nm). Choosing the Cluster option creates a basis set
that is chosen based on tertiary structure.

Secondary Structure Fit Results
The results of a protein secondary structure fit are presented as
fractional composition of secondary structure motifs. These
include alpha-helix, beta-strand, turns, proline turns, and
unordered segments. The list of motifs included in the results
will depend on the basis set used to produce the fit. The typical
standard deviation for this fit is 0.06. The sum of these
compositions should be close to 1.0 for a good secondary
structure fit. A graphical display of the fit shows how closely
the calculated spectrum represents the data. A residual plot,
which displays the difference between the calculated spectrum
and the original data, is also displayed with the results.

Using protein secondary structure fits in
GlobalWorks
To fit a CD spectrum using one of the above fits, open the
desired spectrum and click on the data to select the curve. It
will turn yellow and a cursor will appear (see Figure 3.6). Select
the desired fit from the list of Secondary Structure Fits in the
Fits menu. A screen will appear showing the ten basis sets
available for use. Choose the appropriate basis set for the
analysis and click on Apply to initiate the fit. The original (red)
and calculated (blue) spectra are shown on the results page
along with the resulting compositions and residuals. The
typical standard deviation for these types of fits is about 0.06.
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Appendix 5
Interpreting Global Fit Models Kinetic
Mechanisms
Each kinetic model used by GlobalWorks for global fitting can
be expressed in the form of a matrix. This matrix is displayed
on the global fits results as shown below.

Since neither rate is affected by the concentration of B, both of
these entries are 0. The matrix becomes:

dA/dt
dB/dt

To explore how this matrix was generated, first consider the
simple first order case of AJB. A matrix describing this reaction
can be started with two columns labeled A and B. Each row of
the matrix includes expressions of the derivatives of each
species with respect to time

A

B

-k1
k1

0
0

This is the matrix which undergoes matrix exponentiation
during the global fitting process.
Considering the more complicated mechanism of AJ BJ C
where k1 is the rate constant for the first process and k2 is the
rate constant for the second.
The relevant rate expressions are:

A

B

dA/dt=-k1[A]
dB/dt=k1[A]-k2[B]
dC/dt=k2[B]

dA/dt
dB/dt

Therefore, the matrix for AJ BJ C is:
The data in the matrix are generated by considering the effect
of the rate of formation of a species (row) on the species in
question (columns). For example, the data for the row dA/dt
and the column A comes from the following expression:
dA/dt=-k1[A] where k1 is the rate constant for the reaction
AJB
The entry in this position of the matrix therefore is -k1, making
the matrix:

A
dA/dt
dB/dt

B

-k1

dA/dt
dB/dt
dC/dt

B

C

-k1
k1
0

0
-k2
k2

0
0
0

Considering the reversible example AQB with a forward rate
constant of k1 and a reverse rate of k2, the rate equations are:
dA/dt=-k1[A]+k2[B]
dB/dt=k1[A]-k2[B]
resulting in the matrix:

Similarly,
dB/dt=k1[A]
Therefore, the entry in this position is k1.
A
dA/dt
dB/dt

A

dA/dt
dB/dt

A

B

-k1
k1

k2
-k2

B

-k1
k1
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Appendix 6
Demo Data
Demo data is provided with all RSM software and is located in Program Files\Olis Globalworks\Demo Data in the Windows
software. It can be accessed in the Demo data option from the Command Mode in the DOS software. Information on the data
files is as follows:

Data File*

Number of
Species

Correct Model

Comments

xofe125.ols

3

AJ BJ C

Oxidation of xylenol orange with Fe3+

protfold.ols

2

AJ B

Unfolding of T4 lysozyme, very noisy raw data

1EXP.kin

2

AJ…, B

Synthetic single exponential

2EXP.kin

3

AJ…, BJ…,C

Synthetic double exponential

3EXP.kin

3

AJ…,BJ…,CJ…

Synthetic triple exponential

3expneg.kin

3

AJ…,BJ…,CJ…

Synthetic triple exponential, one negative amplitude

3flashes.ols

-

-

3 flashes of a firefly

3species2rates.ols

3

AJ…, BJC

Reduction of cytochrome C with ascorbate

4species3rates.ols

4

AJBJCJD

Synthetic data

5species4rates.rdf

5

AJBJCJDJE

Synthetic data

6species5rates.rdf

6

AJBJCJDJEJF

Synthetic data

Cyto_ascorbate.ols

2

AJB

Reduction of cytochrome C with ascorbate

DCIP.ols

2

AJ …, B

Reduction of DCIP with ascorbate

DCIPHOLM.ols

2

AJ …, B

Reduction of DCIP with ascorbate with holmium filter background

HSA_38_CD.ols

2

NQU

CD Spectra of human serum albumin vs. temperature

Lyso2050_CD.ols

2

NQU

CD Spectra of hen egg white lysozyme vs. temperature

Chaires.ols

4

NQI1QI2QU

Absorbance spectra of DNA vs. temperature

Lyso260182_CD.ols

1

Spectrum

CD Spectrum of hen egg white lysozyme

P05_120H.rdm

1

-

Spectra of overhead lights vs. time

TPLASP1.ols

3

AJBJC

*.ols - Olis Windows data file,
.rdf, .rdm - DOS reduced data file. Data file must be created when opening in Windows. Create data file by selecting Create 3D
from SVD Data under the Tools menu.
.kin - Synthetic kinetic file
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